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This Dance-magazine is a monthly magazine made for and made by ballroom-dancers. Every

month you can read about different subjects all concerning ballroom-dancing. We also give

you the opportunity to put your add or messages in it. You can send them to me by e-mail.

The Dance-magazine is an edition from Fred Bolder’s Ballroom Site

Url : http://www.xs4all.nl/~fghb/ballroom.htm

e-mail : fghb@xs4all.nl

You can download this magazine as a Word-file for free.

Editors:  Fred Bolder & Miranda Jager

Copyright

Nothing of this magazine is to be copied or made public, using print, photocopy, microfilm or

by any other way, without written approval of the publisher.

Fred Bolder’s Ballroom Site is not responsible for the correctness of the information in this

magazine as well as for any damage caused by this information.
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Dance figure of the month

Tango – Rock turn

Man Lady

Nr Rhythm Leg Step Direction Turn Leg Step Direction Turn

1 Slow L Forward 2 R Back 6

2 Slow R Forward 2 L Back 6

3 Quick L Rep. weight 3 1/8 r R Rep. weight 7 1/8 r

4 Quick R Rep. weight 4 1/8 r L Rep. weight 8 1/8 r

5 Slow L Rep. weight 4 R Rep. weight 8

6 Quick R Back 4 L Forward 8

7 Quick L Side 3 1/8 l R Side 7 1/8 l

8 Slow R Close 2 1/8 l L Close 6 1/8 l

This picture shows the direction of the numbers. Direction 1 is the

dance-direction. In the description we talk about the direction of the

man (unless written otherwise), You can find the directions of the

lady and the man in the table.

The rock turn is one of the first figures you learn when you are learning the tango. After that

you learn the promenade turn and you see that there are very little couples still dancing the

rock turn. This is a pity because it is a nice figure, which you can also easily use. That’s why I

made the rock turn the figure of the month.

You start it nearly opposite the wall. We dance two steps forward. After that we replace our

weight to our left leg, which makes us turn a little to the right and we end straight to the wall.

Then we replace our weight to our right leg, which makes us turn a little to the right again.

After that we replace our weight back to the left leg, but we don’t turn. Then we dance with

the right leg one step back. We close the figure with a ‘side-close’, and turn to the left so we

end nearly opposite the wall again. You can also turn more to dance-direction, so you can go

on with a left turn for example.

You can also use the rock turn in a corner if you do not have space for a promenade. In this

case, you only turn on the ‘side-close’part.

You can also see this figure in my dance software.
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Dance music

I think that it’s a good idee to place the favourite dance music of different dancers. Please,

mail your favourite dance music to fghb@xs4all.nl

Here is my favourite dance music.

Slow waltz

At this moment ..........................................................................................Billy Vera

He'll have to go........................................................................................ Jim Reeves

Theme from The Thornbirds

You light up my life ........................................................................... Debbie Boone

Tango

I'm gonna be (500 miles)................................................................. The Proclaimers

Serenata

Slow foxtrot

King of the road.....................................................................................Roger Miller

Raindrops keep falling on my head....................................................... B.J. Thomas

Quickstep

Coco Jamboo........................................................................................Mr. President

Everybody ........................................................................................ Backstreet boys

I've been thinking about you .................................................................London Beat

Na neh nah.........................................................................................Vaya Con Dios

We're going to Ibiza ................................................................................ Vengaboys

Viennese waltz

Think with your heart ........................................................................ Debbie Gibson

The second waltz .....................................................................................Andre Rieu
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Dance music (continuation)

Cha Cha Cha

Denk het niet .............................................................................................. N.U.H.R.

Smooth ..........................................................................................................Santana

Stay....................................................................................................................Sash!

What is love.............................................................................................. Haddaway

Rumba

As long as you love me .................................................................... Backstreet boys

Fields of gold.....................................................................................................Sting

Hou me vast................................................................................................... Kadanz

Sign your name.......................................................................... Terence trent d'arby

Samba

Simarik ........................................................................................................... Tarkan

Tic tic tac.......................................................................................................... Chilli

Paso Doble

Spanish gipsy dance

Jive

All shook up ..........................................................................................Elvis Presley

Grease lightning .................................................................................. John Travolta

Return to sender ....................................................................................Elvis Presley

Man! I feel like a woman! ................................................................... Shania Twain



The Dance Magazine

5

Dance-etiquette
By: Fred Bolder

Just like in traffic, you should keep certain rules in dancing. Below you will find the most

important rules. It is not easy to keep up with these rules, but you do have to try.

• Make sure you are fresh: take a bath and brush your teeth. You are standing closely to

your partner when you are dancing.

• Get your keys etc. out of your pocket. Your partner could get hurt by them.

• Normally the man asks the woman if she wants to dance, but the lady can also ask a man.

• If someone asks you to dance, you cannot say no, unless you have a really good reason for

it. A good reason could be that you don’t know the dance or if you already promised

someone else this dance. In both cases you can suggest to dance the next dance with that

person.

• If you promise to dance with somebody, you have to do it.

• You should accompany your partner to the dance-floor.

• Try to prevent crashes by adapting to one another. Don’t dance in the normal posture, take

smaller steps, dance another figure of just stop are some solutions. If you do crash,

apologise to that couple.

• Don’t stand still on the dance-floor, if you don’t know your figure anymore for example.

• Advanced dancers should watch out for beginners. They have more experience and know

more figures to make way.

• Also give other dancers room on the dance-floor. If the floor is small, try to dance with

smaller steps.

• Don’t get angry with your partner if he or she makes a mistake. He or she will probably

get nervous and make even more mistakes.

• You should not apologise for every mistake you make. Maybe your partner didn’t even

notice.

• If the dance is finished, do not walk straight from the floor. Maybe your partner wants to

dance another dance with you. If you decide you do not want to dance with him or her

anymore you should also accompany your partner back to his or her place.

• Thank your partner for the dance.

Ofcourse there are even more rules, the rules also depend on the partner you dance with.

Actually you can make one rule of all these rules:

Watch out for eachother!!!
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Dancing in a formationteam
By Miranda Jager

Formationdancing is a sort of ballroom dancing in which a few couples (mostly 8) try to

dance the figures at ballroom or latin-american music as synchronic as possible. The most

important thing is that everyone is doing the same things at the same time, both the steps as

the head- and arm-movements. One couple has to be the mirror image from the other couple.

Before a formationteam can dance ‘perfectly’, you need a lot of training. In Germany the

formationdancing is already recognised as an official top-class sport, that is why the Germans

have been Worldchampions formationdancing many times. Speed, synchronic, a lot of

different figures, but especially the looks of the team are very important. The choreography

has to be adjusted to the dancers, because they have to ‘feel comfortable’ in the steps they

dance. If a group dances a line, it should be a strong and fixed one, with perfect patterns. The

dancer should have great skills, both as a dancer, but also mentally, because it is a teamsport

in which all the members should be completely adjust to one another.

The difference between formationdancing and classic ballroom dancing is that you do not

have two persons standing ‘in the picture’, but a whole group. The group should be

completely adjust to one another and it should all be synchronic, so that is even more difficult

than two people who have to adjust to each other.

The demands for the looks are the same: ill kept and all the same. The clothes should be the

same, but there is more. Just like with the classic ballroom dancing, the ladies wear a lot of

make-up en the haircut should be fixed with the ballroom formationdance, the latin does not

require such a haircut.

Formationdancing is, just like the classic ballroom dancing, not a form of dancing which

absolutely has to be done in competitionform. A lot of dancingschools have formationteams

from different levels. In fact, you can start dancing in a formation as soon as you control some

dancing steps, about silver-level. If different couples dance the same figures you will see a

unity. The formationteams from dancing schools sometimes give a demonstration at other

dancingschools. The clothes and the hair will be attuned, but it is not that professional as in

competitiondancing.

The levels at the competitions start roughly the same way as in classic ballroom dancing. You

will start at the bottom with ‘normal’ clothes and if you are good enough you will be

promoted to a higher level. If you start dancing national it looks more professional and more

elegant, this is to compare with the ‘normal’ competition dancing.

Formationdancing is not very popular in the Netherlands yet, but it will become popular in the

future, just like ballroom dancing did….
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The jury
By: Miranda Jager

With reference to the article of Fred about the final exams in the January-number, I thought it

would be nice to write about the thoughts of the jury. Fred did not know exactly on which

things the jury would judge a couple. I am dancing competitions for three years now and

sometimes we even wonder what the jury thinks is important. Sometimes you see a couple in

the final and you wonder why them? This is not hard to understand, because the jury only has

1 ½ minute to look at all the couples (mostly 20 couples on the floor) and to judge them. In

this 1 ½ minute the jurymember has to consider which couples are good enough for the next

round. If a couple dances good at the moment a jurymember looks at them they will get a

cross, which means that jurymember wants to see them back in the next round. If the

jurymember would have more time, they might give other couples the crosses. That will not

happen often, because the jurymembers are very good dancers themselves and based or their

experience they can see very quickly which couples are the best. In the final the jury has more

time. They only dance 1 ½ minute as well, but there are also only 6 couples on the floor, so a

jurymember has more time to look and judge.

During competitions you have more than one jurymember, mostly 4 or 6, this is more fair,

because then it is not only the opinion of one person that counts. Every jurymembers looks at

a couple at a different time and they see different things. When you dance your exams this is

different, because then the opinion of one jurymember counts. This member takes into

account that the couples are very nervous because there are many people watching them.

Competitions dancers know that feeling, but not everyone who dances his exams is a

competition dancer.

Which points the jury judges is very hard to say. I have asked many professional dancers what

they look at, but they look at a lot of things. There is always one point they keep on front,

because they can only look at a couple for a little time. They can look, for example, at the

position, the technique, the feet, the figures, keeping the rhythm or the looks.

Dancecouples dance differently every round, the one feels better than the other one. This can

be because of a lot of reasons. It is very important never to get angry with your partner if it is

not going to well! Talk about it, so you can practice that in the next training and keep

thinking: ‘There is always next time, next time will be better’.
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Dancing with your computer

I have good news for the users of my dance-software! I have made a second dance program.

This program is called ’DansCAD’ and is freeware. You can download both programs from

my site.

http://www.xs4all.nl/~fghb/ballroom.htm

‘DansCAD’ is not a replacement for ‘Dans’, but it is more extensive. Since ‘DansCAD’ is

still in a developing stage, the chance for mistakes in the program is a little bigger. Both

programs have their advantages and disadvantages compared to one another.

I made ‘DansCAD’ because I learn figures at my dance lessons which are too big for the

‘Dans’program. In ‘DansCAD’ you can adjust the size of the dancefloor yourself.

What possibilities has ‘DansCAD’, what ‘Dans’ hasn’t?

• You can rotate the feet with every angle you wish. And not only in steps of 22.5 °.

• You can adjust the size of the dancefloor yourself.

• Zoom and Pan give you the opportunity to see any part of the dancefloor.

• You can change the figures at the same way as in AutoCAD.

• Making changes is a lot easier because of the functions Snap, Grid and Ortho.

• It is possible to adjust the screen resolution.

• The kick, appel and heel turn have a different appearance.

• You have a pulldown menu and a screen menu. The menu can be defined just the way you

wish.

• You can define quick-keys for commands you use a lot.

• It is also possible to see the last step in the current step. This is also possible with the new

version of ‘Dans’.

• With grips the feet can be moved and rotated very quickly and precisely.

Getting started

Open a figure by clicking Open from the File menu. If you don’t have a mouse, you can also

type open on the command line. There appears a list with figures. Choose a figure by typing

the number followed by Enter. With the keys PgUp, PgDn, Home and End you can navigate

through the pages.

You can play a figure by clicking Play from the File menu. You can also press the Space bar.
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Dancing with your computer (continuation)

Click on Tempo in the Settings menu to adjust the tempo.

Use the command gotostep to view every step you wish.

For the Ladies

With the command manlady you can toggle between the text of the man and the lady.

Click on Man / Lady in het View menu. If the feet of the lady are brighter then you can see the

text of the lady.

Since the lady is used to look from another direction, you can rotate the dance floor by

clicking on Rotate floor in the View menu.

Use the command savevar to save the settings.

More about this next month!
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Nice links

Ernesto's Tango Page

http://members.ping.at/kdf-wien/tango/

Many links to tango sites

Let's dance Salsa

http://www.fromusalive.com/salsa

Learn the salsa online!

Dansschool Waterschoot

http://www.dansschool-waterschoot.com

New site from a dance-school in Eindhoven

Are you obsessed about dancing?

http://www.havetodance.com/articles/bjod.html

Test yourself!

The Perfect Dance Partner

http://www.havetodance.com/articles/news20.html

The perfect dance partner

Helpful Ballroom Dance Pages

http://www.umass.edu/rso/ballroom/pagelist.htm

Helpful sites about ballroom dancing


